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CamRanger Hardware

The CamRanger device is turned on by sliding X
the power switch, located on the side of the M

unit, towards the front of the device. The green ¥|r
power light will illuminate when the unit is g
powered on. Any additional switch present on
the CamRanger currently serves no function.

The charging port is located next to the power \\\ < = P
switch. The male micro B end of the provided NG/ l_ ,

. . . . _I = Power Switch
white charging cord is connected to this port. USB Port Charaing C .
The other end of the charging cord can be (connects to camera) arging -onnector

connected to a female USB port that provides
power, such as a computer or through an AC adapter.

When the device is charging, a yellow/orange light will illuminate indicating that it is
charging. The yellow/orange light will turn off leaving only a green power light when it is
fully charged. Charging takes approximately 2 hours.

The CamRanger battery is accessible by removing the bottom cover. The bottom cover is
the side with the CamRanger serial number. Simply grasp the side edge/corner of the cover

4943054y -,
P
LobUEY ey "

near the USB connector and pull back to remove. To replace the cover, first place the two
lower tabs into the slots and then snap in the top.
2

CamRanger is not water-resistant in any way and should not get wet.

A black neoprene case is provided to assist in attaching and securing the CamRanger, note
that this pouch is not waterproof. The case has a carabineer to facilitate hanging from a
tripod, belt loop, etc. Do not just hang the CamRanger by the cable as it will put strain on
the USB connectors as well as possibly disconnect.
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CamRanger Registration

Before a Mac can be used with a CamRanger, the application should be loaded on the Mac,
at no additional cost to the user, from the Apple Mac app store or from the downloads page
on the CamRanger website, http://www.camranger.com/downloads. Once downloaded, the
CamRanger application needs to be registered. Registration requires Internet connectivity.
Before proceeding, confirm Internet connectivity (do not connect to the CamRanger
network).

Launch the CamRanger application and the following screen appears. If the registration
pop-up does not appear, from the “Help” tab on the Mac CamRanger menu bar, click
“Register,” and the following screen will appear.

(@l
-y

Please enter your serial code located on the back of your CamRanger:

CamRanger
Serial #: ABCDEFGH

Note: you must be connected to the Internet

Register

Enter the 8-character CamRanger serial number. The serial number is located both on the
bottom of the back cover as well as above the battery underneath the back cover. Note: the
serial number contains only letters and NO numbers.

Press the “Register” button to register. A message box will appear indicating registration
was successful and the Mac can be used with the CamRanger. Exit the application and then

proceed with the setup process as detailed below in the CamRanger Setup section.

If registration fails, confirm Internet connectivity and the CamRanger serial number before
contacting support@CamRanger.com for assistance.
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CamRanger Setup

Power on the CamRanger and confirm all four lights briefly appear. The CamRanger will
take approximately 30 seconds until it is fully initialized.

The first time the user connects to the CamRanger from a Mac, the Mac needs to be
registered. See the CamRanger Registration section above.

Once registered, connect to the CamRanger network on the Mac. The network name will be
CamRanger-###, with the last three characters matching the last 3 characters of the
CamRanger’s serial number. Enter the network password, which is the full 8 characters of
the CamRanger’s serial number. The password MUST BE ENTERED IN ALL CAPS.

Connect the CamRanger to the camera with the provided black USB cable. (Note: units
purchased through retailers will have a USB mini cable, which will work with most
cameras. A few select Nikons use a different cable, which may be purchased separately or
the cable that came with the camera will also work.) The male A end is inserted into the
USB port at the end of the CamRanger, and the other end is connected to the USB port of
the camera. Then ensure the camera is turned on. When the camera is connected and
turned on, the green light closest to the edge of the CamRanger device will light.

Launch the CamRanger Mac application. The application will connect to the CamRanger and
the user will be able to control the camera. To attempt to manually initiate a connection,
on the Mac CamRanger menu bar, click “Connection” and then “Connect.” Once connected,
the following screen will appear.

Connected to camera

For common problems with setup and connection refer to the Troubleshooting section at
the end of the manual.
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CamRanger Mac Application

Status Bar Recent Thumbnails
enn CamRangear o
EYMMD Caron E0S 7D | EFSDmm /1.4 USM
PTEY T/ w = 3 A'- D A{,“
R g
T ¥ 2 oe- % .‘}“ Advanced
s > A (AT Control
16_9153.)PG IMG_9155.JPG IMG_91356.)PG IMG_3157.JPG IMG_9158.PG IMG_9159.PG
Tabs
IMG_9159.JPG
150400 s.0Mmp
Main
Image
View
Camera
Properties
Camera
Actions
Image Size
e 00 CamRanger "l
a.:) Canon EOS 5D Mark Ill | EF24-105mm f/4L IS USM Shots: 79

The status bar is located at the top of the application screen and provides the user with a
number of elements.

* From left to right:

o Camera Connection: Indicates if the CamRanger device is currently

communicating with the camera

= Connected: (|

= Disconnected: XX
Camera Battery Status: Indicates the approximate battery charge on the camera
Camera Model Name
Lens Model Name (Note: not all cameras or lenses are supported)
Shots Remaining: Indicates the number of shots currently remaining on the
camera’s removable media using the current settings
* Quitting, maximizing, and minimizing a window

o Red, Yellow, and Green circle on upper left corner:

O O O O
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= Red: This serves no purpose and does not actually close the window. To
close the window, select “CamRanger” on the Mac CamRanger menu bar
and then “Quit CamRanger” or use the 38+Q shortcut.
= Yellow: Used to minimize the window
» (Green: Used to maximize the window
o Click on the extending arrows, located on the upper right corner of the screen, to
view the window in full screen

Recent Thumbnails

IMG_9157.JPG IMG_9158.JPG IMG_9159.JPG

* Asimages are captured, the thumbnails are automatically downloaded and
displayed along the top of the screen. The thumbnails may be scrolled left and right
when more are downloaded than can fit.

* A thumbnail may be selected to view the corresponding image. The image is then
displayed in the main image view. The currently selected thumbnail is indicated
with a yellow outline.

*  When both a JPG and RAW file format is captured, only the JPG thumbnail is
displayed.

* For Canon, JPG and RAW files can be viewed. For Nikon, JPG, TIFF and RAW can be
viewed.

* A small red “R” icon on the upper right of the thumbnail indicates that it is a RAW
image. A small green “T” indicates TIFF, while no icon is used to indicate JPG
formatted images.

* Note: only thumbnails for images captured within the current CamRanger session
will be displayed.
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Main Image View

Live view and captured images are displayed within the main image view.

Live View Images

To initiate live view, click on the eyeball symbol located within the camera action controls
on the bottom right of the application screen. In live view, the image on the screen is
automatically updated as live view images stream in. The exact frame per second rate is
very much dependent on CamRanger WiFi signal strength, the camera, and the Mac specs.
However, assuming a good connection, live view frame rate will be about 7 - 18 fps.

When in live view, the main image view may be clicked once to focus at that point. Note
that for Canon cameras, the outer edges of the image cannot be focused on. Double clicking
will zoom in the viewing window and double clicking again returns to regular size.

A live view histogram may be toggled on or off from the “Data” tab as described in the
Advanced Tab- Data section found on page 9. Toggling the histogram on will generate a
histogram for each live view frame; however, at the cost of a decreased frame rate. Toggle
the histogram off to maximize the frame rate.

Canon cameras can display the live view image on the camera and Mac and allow the user
to trigger images with the camera by activating the camera’s live view button after starting
live view within the CamRanger application. Nikon cameras do not allow any control of the
physical camera while live view is active within the CamRanger application.

Captured Images

Captured images will be displayed in the main image view in one of two ways, by selecting
a thumbnail in the thumbnails section of the application or through the Auto-View Images
feature. The Auto-View Image feature is useful when capturing images from the camera
and using the Mac application for image display. When this feature is selected, pictures will
automatically display in the main image view screen. This feature can be turned on or off
by selecting “CamRanger” on the Mac CamRanger menu bar and then “CamRanger
Preferences.” For more information about this feature, refer to the Mac CamRanger Menu
Bar- Preferences section found on page 15.

When a thumbnail is selected for viewing, the image will be displayed on the main image
view and can be zoomed in at 50%, 100%, 200%, or fit to screen by selecting the
magnification of interest below the image. The image can then be panned using the mouse.

Images displayed in the main view are NOT saved by default, but are instead just
temporarily cached. Individual images can be saved by selecting “File” from the Mac
CamRanger menu bar and then “Save” or “Save As”. For further saving options including the
ability to automatically save all pictures, refer to the Mac CamRanger Menu Bar- Preferences
section found on page 15.

© CamRanger - Patent Pending 8



To view the images on the camera’s memory card select “View” on the Mac CamRanger
menu bar and then “Card Contents.” A new window will appear displaying thumbnails of
the images on the camera’s removable media. Double-clicking a thumbnail will display the
image within the main image view. Additional features for downloading or deleting images
are also available. For further information about the card contents, refer to the Mac
CamRanger Menu Bar- Card Contents section found on page 17.

Advanced Tabs

There are four tabs providing advanced information or controls: Data, Focus, Timer, and
HDR.

Data

Focus = Timer = HDR

The data tab shows an RGB histogram and meta-data
associated with the image in the main image view. The
following meta-data is provided:

¢ Shutter Speed
* Aperture
* MegaPixels (Note this is not file size, but image

resolution)
* ISO
* Metering Mode IMG_9153.IPG 1/6 2.8
* Exposure Compensation Value 1S0400  8.0MP

Within live view the data tab will simply inform the user that live view is on and provide a
toggle switch to toggle the display of the histogram. The histogram is updated in real-time,
but at the cost of slowing down the frame rate.

Focus
[Data [N Timer HDR |

The focus tab is only enabled during live view and provides
Focus Adjust

advanced focusing controls.

Focus Nearer Focus Further

Focus Adjust a n n ’ u B

There are two sets of buttons to move the lens’ focal
plane nearer or further from the camera. Each set has [REEEEEETHE

three buttons with different sized arrows to specify a Step Size Number of Shots
large, medium, or small step in focus. Tap the button [Medium | ~] 3 |~]
to move the focus by a single increment, holding down

the button will have no affect.

DOF Preview

© CamRanger - Patent Pending 9



Focus Stacking

Focus stacking is a process of taking multiple captures with slight changes in focus
and then post processing them to enhance the depth of field. This control allows the
user to set the focus step size to take between in each shot and the number of shots
to take. Each focus step will move the focal plane further from the camera. So the
user will want to set the focus to the nearest plane desired to be in focus and start
the stacking process from there. If too few captures were taken, the process can be
restarted from where the initial stacking ended. Note: post processing of the images
is not done within the CamRanger application.

DOF Preview
While in live view the Depth of Field can be previewed by selecting the “DOF
Preview” located within the Focus tab. This function can only be activated in live

view.
Timer
The timer tab allows the use of the CamRanger as an R FDR
intervalometer as well as specifying exposure times when the Time Lapse
camera is in bulb mode. el veley [0 : [
Time Lapse Num Shots a
* The entry fields are used to specify the initial delay shot Delay [ :
before the first shot, the number of shots to take, and 8 HDR - 3 Shots - Step Size 1/3
the delay in between each shot. Bulb

e After configuring the settings, click the “Start” button
to begin the intervalometer process.

* The intervalometer commands are stored on the
CamRanger device, the Mac does not need to remain
on or connected once the intervalometer command
is initiated.

* The “Shot Delay” should not be used for precision timing, particularly when the
delay is only a few seconds or less.

* Once an intervalometer sequence is begun, it can only be cancelled by turning off
power to the CamRanger device.

* Time Lapse - HDR

o Ifthe camera is in manual exposure mode, a small HDR check box will
appear allowing the combination of a time lapse and HDR sequence.

o Ifthe HDR check box is set to on, for each time lapse capture, CamRanger
will actually take a sequence of bracketing images using the bracket
parameters as specified within the HDR tab.

Bulb capture is only available

while the camera is in bulb mode.

© CamRanger - Patent Pending 10



* Time Lapse - Bulb
o Ifthe camera is in bulb mode/shutter speed and the camera supports
bulb shots, CamRanger will take Bulb shots during the time lapse. The
bulb duration is specified by the Shot Duration, located within the Bulb
section immediately below the Time Lapse section.
* Before starting the time lapse sequence, a dialog will appear informing the user
of the time lapse parameters and provide an opportunity to cancel.

Bulb

* The Bulb controls are only enabled when the camera is in bulb mode and the
camera supports remote bulb shots.

* The entry fields are used to specify the initial delay before the first shot and the
length of the exposure.

* After configuration, click the “Start” button to begin the bulb process.

* The bulb commands are stored on the CamRanger device and the Mac does not
need to remain on or connected.

HDR

The “HDR”, or Advanced Bracketing, tab can be used to generate a

. . . Data | Focus | Timer [N:Ip:8S
series of photos with varying exposures.

(1IN Shutter Speed n

* Advanced Bracketing is only enabled when the camera is in

Manual mode Initial Delay Start Value
* The Property field specifies the camera property to be 0o Jf 00 [1/30__|~]
varied. There are three options, Shutter Speed, Aperture, and

Number of Shots Stops

ISO.

* The Initial Delay field specifies the amount of delay, if any, to
take before beginning the bracketing sequence.

* The initial value for the selected property is set with the
Start Value field.

* The total number of images to capture is specified by the Number of Shots field.

* The possible Step Size values are up to 3 stops and specify how many stops to vary
the exposure between each capture.

* The valid values for the Number of Shots are automatically determined based on the
values specified for Start Value and Step Size. For example a step size of 1/3 stops
will allow more shots than a step size of 3 stops.

* The starting point of the bracket is set within the settings and can begin at the
shadows (lowest exposure), mid-point, or highlights (highest exposure). If the
starting point is set to mid-point, the resulting sequence will start at the lowest
exposure but with the initially set value as the mid-point. See the Advanced Settings
section for more information on setting the HDR start point.

* After configuration, press the “Start” button to begin the bracketing process.

* HDR sequences may be done with Live View being active for Canon, but not Nikon.

* Note: the post processing is not done within the CamRanger application.

IE1 6 13
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Camera Properties

Auto Exposure Mode

P~ T —§——

Aperture === :
shurwr_pusio | 128 [sowo]'c,p,,
Spee Mode
teri [\ZI AWB White

puihemm— B |ance
Image _L 4| + Focus
Format .

Mode

Exposure Compensation
& Bracketing

The above diagram indicates the camera properties, which are also listed below, that can
be set using the application:

* Auto Exposure Mode Shutter Seed

* Aperture  ISO

* Metering Mode * Capture Mode

*  White Balance * Image Format

* Focus Mode * Exposure Compensation and Bracketing

Not all properties can be set for all cameras or in all modes. For example, the diagram
above is from a session with a Canon camera and for most Canon'’s the auto exposure mode
and focus mode cannot be set. Disabled properties are indicated with a darker button
background.

Exposure Compensation & Bracketing

Clicking the bracketing button will display the following control:

Clicking the exterior arrows pointing to the left and right will adjust the exposure
compensation. Holding down the arrow will move the exposure compensation to its
respective limit. The two buttons at the middle control the bracketing amount. Clicking the

© CamRanger - Patent Pending 12



arrows pointing in will reduce the bracketing amount, while pressing the arrows point
outward will increase the bracketing amount.

The bracketing is not set until the “Set” button is pressed. The “Close” button will dismiss
the dialog. Pressing “Close” without pressing “Set” will effectively cancel any adjustments

made.

Camera Actions

Movie Mode

- . " M Auto / Manual
Live View a m AF Focus Toggle

Capture Trigger
Image Capture
Capture
o The “Capture” button initiates the camera trigger. The exact camera behavior

is dependent on the camera and camera properties, most importantly the
capture mode.
For most capture modes, such as single, timer, or quiet, the button performs
the image capture as expected. It should be noted that for some cameras,
advanced modes such as remote or timer will behave as single capture mode.
Continuous capture mode differs between Nikon and Canon.
= Nikon: After selecting a continuous drive mode a dialog is displayed
allowing the user to select the number of images to capture. When the
“Capture” button is pressed, that number of images will be captured.
= Canon: When in a continuous mode, pressing and holding the
“Capture” button behaves in the same way as pushing the physical
trigger on the camera.
[t is noted that there can be a very slight lag between the pressing of the
“Capture” button and the image capture. The delay can be more pronounced
while live view is active. For time critical applications, a remote trigger, such
as an RF trigger, can be used in combination with the CamRanger.

Auto / Manual Focus Toggle

@)

@)

The AF/MF Focus toggle button allows the user to change the focusing
between auto and manual without having to physically adjust the camera.
This AF/MF adjustment is not possible for all cameras in all modes. For
example, some Nikon cameras are required to be connected in “PC” mode,
which is accessible by selecting “Connection” on the Mac CamRanger menu
bar followed by clicking “PC”.

© CamRanger - Patent Pending 13



o After any touch or incremental focusing while in live view, the focus mode
will automatically attempt to switch to manual focus such that the user
specified focus is not overridden by auto focus upon capture.

Live View

o The “Live View” toggle button is used to turn live view on and off.

o When live view is on, the main image view is updated with live view images
as well as updating the RGB histogram in the Data tab, if the live view
histogram is turned on.

o Note: running live view is relatively intensive and there may be slight
performance lags in other areas.

Movie Mode

o The “Movie Mode” toggle button is used to turn live view on and off, but
within movie mode (only for supported cameras).

o When movie mode is on, the main image view is updated with the live
images.

o The “Capture” button changes to “Record” and pressing the “Record” button
will start and then stop the recording of a movie.

o Note: movies cannot be downloaded to the Mac using the CamRanger.

Mac CamRanger Menu Bar

| ® CamRanger File Connection View Window Help

The CamRanger menu bar located at the top of the Mac display contains many useful
functions allowing the user to manage the connection, set options and controls, access to
the camera’s card contents, and get help.

© CamRanger - Patent Pending 14



CamRanger: Preferences

The CamRanger preferences are useful for saving, viewing, and HDR options. The
preferences are accessible by clicking “CamRanger” on the Mac menu bar and then
selecting “CamRanger Preferences” on the dropdown.

e 00 CamRanger Preferences

Saving

Saved Images Directory

/Users/admin/Pictures | Browse

|| Custom Prefix

|| Auto-View Images  [_| Auto-Save Images
Viewing
[] File Name [ | Grid Lines Aspect Ratio | v |

[ Nikon RAW (NEF) Quick View

Controls

HDR Start Point
'Mid-Point | ¥ |

Saving

* Saved Image Directory: As images are captured they can be saved into a specified
directory. If pictures from the camera’s memory card are downloaded to the Mac
they will be stored in this folder. Itis noted all images are stored on the camera’s

memory card.

* Custom Prefix: This will give the images taken during the session a unique title

preceding the image number when saved to the card.

* Auto-View Images: This feature will automatically display images as they taken.
Pictures will display regardless of whether they are captured from the Mac or the

camera.

* Auto-Save Images: When this feature is selected, the images will automatically be
saved to the directory during the CamRanger session regardless if the images are

captured from the Mac or the camera.
Viewing
* Name: Displays the images file name at the bottom left of each image
* Grid Lines: Overlay a 3x3 grid over the main image view

© CamRanger - Patent Pending
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Aspect Ratio: Overlays red lines over the main image view to give the user visual
feedback on common cropping ratios. Note: this information is not saved with the
image.

Nikon RAW (NEF) Quick View: The NEF files will be viewed as a compressed JPG
image

Controls

File:

HDR Start Value: Specifies where the selected HDR property value is within the
bracket, at the most exposed point (Highlights), least exposed point (Shadows) or in
the middle (Mid-Point).

Saving Options

The “Save” and “Save as” options are beneficial for users who do not want all images
captured to be saved onto the Mac.

Save: The image displayed on the main viewing screen can be saved to the default
directory by selecting “File” on the Mac CamRanger menu bar followed by “Save.”
Save as: The image displayed on the main viewing screen can be saved to any
directory and any name by selecting “File” on the Mac CamRanger menu bar
followed by “Save.”

To auto-save images as they are captured, refer to the Mac CamRanger Menu Bar-
Preferences section found on page 15.

Connection

CamRanger Connection: A state dependent “Connect” or “Disconnect” button is
available to the user as a troubleshooting option to avoid closing the application in
the case of connection problems.
Nikon Connection Mode
o After selecting “Connection” on the Mac CamRanger menu bar, the options of
“PC” and “Camera” are in the dropdown.
= PC: PC mode allows more control over properties within CamRanger;
however, any properties changed are not maintained, and changing
settings on the physical camera are not recognized. Additionally,
images cannot be physically triggered from the camera.
= Camera: Allows the camera to be physically used as normal; however,
not all properties will be enabled within CamRanger. The CamRanger
application must be set to Camera mode to allow physically triggering
from the camera.
= [tshould also be noted that the connection mode can not be changed
while live view is active.
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View

The view drop down provides access to the camera’s card contents and options for control
accessibility for the Mac application display

Card Contents

6 0 O Camera Card Contents

=
2G6A9200.CR2 2G6A9198.CR2 2G6A9197.CR2 2G6A9196.CR2
2G6A9199.CR2

"

2G6A9192.CR2 2G6A9191.CR2

2G6A9193.CR2

3 R R <R s
~ . Yoo -

2G6A9190.CR2 2G6A9189.CR2 2G6A9188.CR2 2G6A9187.CR2 IMG_9186.CR2

To view the card contents select “View” on the Mac CamRanger menu bar and then “Card
Contents.” By doing this a new window will pop-up, as seen above. The card contents will
display thumbnails of the images on the camera’s removable media. The application will
initially load the most recent thumbnails. To load more thumbnails, press the “More”
button at the bottom of the window. As seen in the picture above, a small red “R” icon on
the upper right of the thumbnail indicates that it is a RAW image. A small green “T”
indicates TIFF, while no icon is used to indicate JPG formatted images.

Any number of thumbnails can be selected by pressing a thumbnail, or all may be selected
by pressing “Select All” at the bottom of the window. Selected thumbnails will have a
yellow border around them. After selecting thumbnails they may either be deleted or
saved. The “Delete” button at the lower left will first prompt the user to confirm, and then
delete the associated images of the selected thumbnails from the camera’s removable
media. The “Save” button at the lower right will save all associated images of the selected
thumbnails to the image directory specified in the preferences. Images are saved
regardless of format.

Images within the card contents view can be viewed by double clicking on the image. The
image will then appear in the main image view window.

© CamRanger - Patent Pending 17



Note that the thumbnails are presented in chronological order beginning with the most
recent. However, for Nikon they are grouped first by format, such that all JPG’s will be
listed, then TIFF’s, and finally RAW images.

Controls

When the “Control” function is turned on, the camera settings and image capturing can be
controlled on the Mac since the advanced controls tab, camera properties, and camera
actions are accessible on the right hand side of the application. Thumbnails of the images
captured within the CamRanger session will appear on the upper portion of the screen, the
main image view will show live view or captured images.

When the control function is turned off, the advanced controls tab, camera properties, and
camera actions will not appear on the application screen, while the thumbnails of images
taken within the CamRanger session will appear on the upper portion of the screen and the
main image view will display the captured images. The camera settings and image
capturing can be controlled from the camera and are not controlled on the Mac application.

Image Only

When “Image Only” is selected, the advanced controls tab, camera properties, and camera
actions on the right hand side of the application are not. The thumbnails of images taken
within the CamRanger session will not appear on the upper portion of the screen.

When “Image Only” is not selected, the advanced controls tab, camera properties, camera
actions, and thumbnails are accessible on the CamRanger application.

Window

The “Window” dropdown found on the Mac CamRanger menu bar allows the user to
minimize and zoom the screen, bring the CamRanger windows to front, and access the
camera card contents.

Help

The “Help” dropdown found on the Mac CamRanger menu bar is useful for registering
CamRanger units and to access this help manual.

* Registration: By clicking “Register” the user can register a CamRanger. The user

must be connected to the Internet to complete the registration.
* CamRanger Help: Click “CamRanger Help” to view this document.
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Incorporation with Lightroom or Aperture

While one cannot control the CamRanger from within Lightroom or Aperture, one can
specify a folder to automatically download images to, for saving options refer to the Mac
CamRanger Menu Bar- Preferences section found on page 15. This folder can be set to as a
“watch” folder within Lightroom or Aperture and set to be automatically imported.

Tips & Troubleshooting

Below are some tips and troubleshooting for common questions or issues arranged by
category:

Registration

[f the CamRanger Mac application is re-installed, the Mac may require the
CamRanger to be re-registered.

Most registration issues are due to not having Internet connectivity or entering the
serial number incorrectly.

If you still have issues, please email support@CamRanger.com for assistance.

Connection

Make sure the CamRanger is fully powered on and initialized (it should take
approximately 30 seconds). The power light and WiFi light should both be on.

The password to connect to the CamRanger WiFi is the CamRanger serial number in
all CAPS. If there are still issues connecting, turning the WiFi off on the Mac may
help.

If the CamRanger application is connected to the CamRanger device, but no camera
is connected, it will attempt to connect to a camera approximately every 5 seconds.
If the Mac is outside of or near the edge of the range of the CamRanger hardware
there will be connection problems.

Disconnect and reconnect the CamRanger by selecting “Connection” on the Mac
CamRanger menu bar then “Connect” to force a new session/connection.

Power cycling the camera and CamRanger as well as restarting the application will
completely refresh the connection.

When the camera battery begins to get low, certain commands may start to fail or a
connection may be refused.

The CamRanger hardware can only be connected to a single Mac at a time.

A second network connection, such as with an Ethernet cable, will likely cause
connection failures.

[f there is an inconsistent or intermittent connection, the issue is likely related to the
USB connection. A different USB cable will often fix the problem.
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Speed

The CamRanger has all the same distance and interference limitations as normal
WiFi. Long distances and solid objects will slow the connection speed.

The CamRanger application can handle very large image files. However, waiting for
those files to transfer from the camera and then over WiFi can be time consuming. A
common operating mode is to shoot RAW along with a small or medium sized JPG.
Newer and faster Mac computers do perform better overall, particularly for
intensive tasks such as showing the 100% resolution images.

Commands

Depending on the camera and the mode, capture can fail if the camera fails to
acquire focus.
Intervalometer and Bulb commands are stored on the CamRanger hardware such
that the Mac does not need to remain on and connected.
When an operation, command, or setting is not available or not working the issue is
often related to the camera setup. For example:

o Toggling to AF is disabled if the camera lens switch is set to MF.

o Live view will fail on Canon cameras if Live View Shooting is disabled in the

camera’s menu.

o Capture fails because the removable media on the camera is full.
For Canon cameras, the Live View focus mode within the camera’s menu must be set
to “Live View”.
Adjusting or viewing the number of bracketing shots is not currently supported. The
display assumes three shots. However, if the number of shots is actually 2, 5, 7, 9,
etc. the bracket amount is still correct it will just incorrectly display 3 shots.
Some features are simply not supported by some cameras. For example continuous
capture mode is not supported on the Canon 40D and many Nikons do not support
bulb shots. See the camera capability matrix at www.CamRanger.com for more
detailed information.
There is no way to cancel an Intervalometer or Bulb command. The only way to stop
it is to power off the CamRanger device.

Images

The thumbnails are not downloaded until after the image has been recorded to the
camera’s card. On most cameras this is relatively quick. However, depending on the
camera, speed of removable media and number of shots taken in succession, there
can be a lag.

CamRanger can be used to view and download pictures captured through other
means. So a photographer could be capturing images, or a RF or light trigger could
capture images and the CamRanger application would automatically download the
thumbnails.
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